For more information contact Minnesota State Colleges and Universities System Office e-Builder Support Team

Mailor Moua
Mailor.moua@minnstate.edu
(651)-201-1782

Website:
http://www.minnstate.edu/system/finance/facilities/design-construction/index.html
# Contents

e-Builder Login ............................................................................................................................................................3  
e-Builder Home Module (Home page) .......................................................................................................................4  
Projects .......................................................................................................................................................................5  
   Access Project Page .................................................................................................................................................5  
Documents ..................................................................................................................................................................6  
   Access Project Documents Page .............................................................................................................................6  
      Upload Documents .............................................................................................................................................7  
      Move Documents ...............................................................................................................................................8  
      Check Documents Out ........................................................................................................................................9  
      Check in Documents ........................................................................................................................................10  
      Check In by Uploading into Folder ...................................................................................................................10  
      Check In via File Properties Page .....................................................................................................................11  
      Compare Documents .......................................................................................................................................11  
      Send Documents ..............................................................................................................................................12  
      Edit Documents ...............................................................................................................................................13  
      Redline Documents ..........................................................................................................................................14  
      Open Redline Markups .....................................................................................................................................15  
      Save Redline as PDF or Image File ....................................................................................................................17  
Processes .................................................................................................................................................................18  
   Start a Process .....................................................................................................................................................18  
   Take Action on a Process .....................................................................................................................................19  
   Filter Processes ....................................................................................................................................................21  
Architect/Engineer (A/E) role in e-Builder ..................................................................................................................23  
Consultant (Non-AE) role in e-Builder ....................................................................................................................23  
Contractor role in e-Builder .....................................................................................................................................24  
List of all Workflow Processes in e-Builder .............................................................................................................25
e-BUILDER LOGIN

There are two ways to log into e-BUILDER. If you were assigned a StarId, use the StarId Login Page. Otherwise, use the e-BUILDER Login page. See instructions below:

1. StarId Login Page - use StarId and password.
   a. In the URL of the Browser, type in https://starid.minnstate.edu/go/ebuilder, Enter.
   b. StarId Login page displays, enter **StarID and Password** to sign in.

2. e-BUILDER Login Page - use Username and password.
   a. In the URL of the Browser, type in https://app.e-builder.net
   b. Enter username and password, click on Log In.
e-Builder Home Module (Home page)

When log in to e-Builder, users will land on the Home page. Two content areas on the home page that user need to know are Workflow in your court table and the Announcement section.

- **Workflow in your court**
  This table includes workflow process instances that are in the users step and required user to take an action or comment on. The table listed the Project Name, Name of the process, Subject, and Step that requires user action or comment.

- **Announcements**
  This section contains links to the e-Manual and Video links on how to access module in e-Builder.

---

**Announcements**

Link to EPMS 11
[http://www.its.mnscu.edu/reportanddataserv](http://www.its.mnscu.edu/reportanddataserv)

Video on Home Page

Video on Documents Module
[https://www.youtube.com/watch?v=2YuUgssS4sA](https://www.youtube.com/watch?v=2YuUgssS4sA)

Video on Process Module
[https://www.youtube.com/watch?v=4o5y000nzxw](https://www.youtube.com/watch?v=4o5y000nzxw)

Video on Standard Reporting
[https://www.youtube.com/watch?v=jgjdclwth5o](https://www.youtube.com/watch?v=jgjdclwth5o)

Video on Calendar Module
[https://www.youtube.com/watch?v=dQn9eUR_C](https://www.youtube.com/watch?v=dQn9eUR_C)

To contact e-Builder Support directly
Please call (888) 288-5317 or email support@e-builder.net.

e-Manual
[http://www.mnstate.edu/system/finance/faq/construction/prp_emph/Email%20index%20version%202.0.html](http://www.mnstate.edu/system/finance/faq/construction/prp_emph/Email%20index%20version%202.0.html)
Access Project Page

There are two ways to access the Project Details page. The first method is from the Top Navigation tabs, which should be used if you are not already in a project. However, if you are in another module within the same project, the best method of access is from the Project Menu, which will eliminate the need to reselect your project.

**If you need to choose your project:**

1. Click **Projects** from the Top Navigation tabs.

2. Click the **all projects** drop-down arrow and select your project. The Project Details page displays.

**To remain in the current project:**

If you are already within a project, you can access the Project Details page via the Project Menu located in the Left Navigation Pane.

1. From the Project Menu, click **Details**. The Project Details page displays.
Documents

Access Project Documents Page

There are two methods of accessing the Project Documents page. The first method is from the Top Navigation Tabs, which should be used if you are not already in a project. However, if you are in another module within the same project, the best method of access is from the Project Menu, which will help you avoid having to reselect your project.

If you need to choose your project:

1. Click the Documents tab located on the Top Navigation Tabs.
2. Click the All project... drop-down list and select your project. The Project Documents page displays.

To remain in the current project:

If you are already within a project, you can access the Documents module via the Project Menu located in the Left Navigation Pane.

1. Click Documents. The Project Documents page displays.
Upload Documents

Tip: In IE 10, Firefox, Chrome, and Safari browsers, you can simply drag and drop documents from your local directory onto the Content Pane of the selected folder. Also, throughout e-Builder Enterprise, you can drag and drop files onto the Attached Documents tab using any of the above mentioned browsers.

To upload documents:

1. Go to the Project Documents page.

3. Select the folder that you want to upload files to.

4. Click the Upload link. The Upload Documents window displays.

5. Click Select Files to select file from your computer.
If multi-file upload is not your default upload method, click the **Upgrade to the Multi-file Upload Tool** link located in the upper-right corner of this window.

Or

If multi-file upload is already being used, drag and drop files from your machine onto the Upload Documents window.

6. Click **Upload Now**.

### Move Documents

You have the ability to move files between folders and across projects. Moving files automatically deletes them from the original location. When a file is moved between projects, all of the history associated with the file is deleted. When using this feature, you do not have to manually delete old files after they have been copied over. If you do not want to delete the original document, you might choose to **copy documents** instead.

To move documents to different folders or projects:

1. From the Project Documents page, navigate to the file(s) you want to move.

2. Select the check box next to the file(s) you want to move.

3. Click the **Move** link located above the file list. The Move File(s) window displays.

   **Note:** Only the user that upload the document and administrators have the ability to move the document to a different location.
4. To move files to a different folder within the same project, click the folder name. You are prompted for confirmation. Click OK.

Or

To move files to a different project, select the project from the Move [number of files] to Project drop-down menu. Navigate to and select the destination folder. Click OK on the confirmation dialog box.

Check Documents Out
The Check Out feature in e-Builder allows you to hold exclusive rights to upload new versions of a document. When a document is checked out, all other users are blocked from uploading a new version of the file. The benefit of using this feature is that all users are informed that you are making updates to the file, and it prevents them from uploading their changes while you have the file checked out.

To check out documents:

1. From the Project Documents page, navigate to the file(s) you want to check out.
2. Select the check box next to the file(s).
3. Click the Check Out link located above the file list.
4. To download the file at this time, click OK.

Or

5. To confirm the check out, but not download the file, click Cancel.

Undo Check Out
In that event that files were checked out by accident, the person that checked the file out has the ability to reverse this action and undo check out.

To undo check out:

1. Go to the Project Documents page.
2. Navigate to the folder where the file was checked out of.
3. Click the file’s Properties link. The File Properties - General Tab window displays.
4. Click Undo Check Out.
5. Click Save.
Check in Documents

Only the user that checked out the document and administrators have the ability to check in files. In the event that documents were checked out by accident, you can undo check out. There are two other ways to check in a file; by uploading the file (with the same name) into the folder it was checked out of, or by clicking the 'Check In' button in the File Properties window. You will not be able to check in a document if its name has changed because it will be considered a new file. Detailed steps for all methods of checking in documents are provided below.

- Check In by Uploading into Folder
- Check In via File Properties Page

Check In by Uploading into Folder

To ensure a successful check in, please make sure that the file you are checking in is the exact name of the file that was checked out. The version number will automatically update after the file has been uploaded.

To check in a file by uploading it:

1. Go to the Project Documents page. For instructions.
2. Navigate to the folder where the file was checked out of.
3. Click Upload. The Upload Documents window displays.
4. Click Select Files to navigate to and select the file you want to check in.
5. Click Upload Now. A confirmation message displays.
6. Click OK. If document custom fields are enabled on your account, the Update Custom Fields window displays.
7. Click Save. A confirmation message displays.
8. Click Close.
Check In via File Properties Page

**Note:** If a different file name is checked in, the new file name will be used, and the version number will be updated.

To check in a file via file properties:

1. Go to the Project Documents page. For instructions.
2. Navigate to the folder where the file was checked out of.
3. Click the file’s **Properties** link. The File Properties - General Tab window displays.
4. Click **Check In**. The Upload File page appears.
5. Click **Browse**.
6. Navigate to and select the file.
8. Click **Save**.

Compare Documents

You have the ability to compare documents to each other in order to identify the changes that have been made to the file. You can view files in different ways to best suit your needs; overlays with difference detectors, side-by-side views, and highlighting the additions and deletions are all options that are available to you. Simply click the ‘Compare With’ link of a file in the Documents module to get started.

To compare documents:

1. Go to the Project Documents page. For instructions.
2. Navigate to one of the documents you want to compare and click the **Compare With** link.
3. The Compare Documents from [Project Name] window displays.
4. Select the check box next to the other document to use in the comparison.
5. Click **Compare**. The files open in the Compare Tool.
Send Documents

The send feature allows you to send files directly from the Documents module to individuals who are not licensed e-Builder users or to license holders who do not have access to specific folders on the project. Files can be sent via email or fax. You can also notify internal users of files by choosing the 'notify' option. This sends users the name of the files and a link to where the files can be retrieved in e-Builder. You can send/notify of a single file or a group of files located in the same folder.

To send files or notify users from the Documents module:

1. Click Documents under the Project Menu
2. Navigate to the folder where the file(s) is located
3. Check the check box next to the file(s) to select it
4. Click the **Send** link located above the file list. The Send File(s) window displays.
5. Select a method for sending.
   - **Email** - email files to internal or external project participants
   - **Fax** - fax files to internal or external project participants
   - **Notify** - notify internal project participants
6. Complete all necessary fields.

**Tip:** When sending an email, use your keyboard to auto-fill and select the desired email addresses. Begin typing the recipient's name or email address then use the arrows to highlight the email of choice, and then click **Tab** to make the selection.

7. Click **Send**.
Edit Documents

Note: This feature is only compatible with Microsoft® Office versions 2010 and above. If an earlier version of Office is installed on your machine, the Edit link will be disabled.

To edit documents in place:

1. Click the Edit link next to the file you wish to edit. The file opens in its native application.

2. Make changes as necessary and remember to save along the way.

Note: You are able to navigate away from the document and e-Builder if necessary - your changes will be saved, as long as you save the file in its native application.

3. When your edits are completed and you're ready to check the file back into e-Builder, click CheckIn next to the file. A message informs you that a new version of the file will be saved.

4. Click OK. If document control is enabled, you are prompted to complete document custom fields.

5. If necessary, update document custom fields, click Save, and then Close.
Redline Documents
To redline documents:

1. Go to the Project Documents page. For instructions.
2. Navigate to the file you want to redline.
3. Click the Redline link located below the file name. The file opens up in a separate window.
4. Click the Markup icon located in the upper left corner of the page. An action menu appears.
5. Click New.
6. Use the toolbar located on the Left Navigation Pane to mark up the document.

7. Once the document has been marked up, you can take any of the following actions:
   - To save the file, click the Markup Save icon.
   - To print the file, click the Print icon.
   - To save the file as a CSF, PDF, TIFF or JPG, click the Save and Publish icon and click the desired format.
Open Redline Markups

Multiple markups can be added to a single file, and each markup is saved separately. By accessing the properties of the file you can view all saved markups.

To open redline markups:

1. Go to the Project Documents page.

2. Navigate to the redline file you want to open, and then click the file’s Properties link.

The File Properties window opens.

3. Scroll toward the bottom of the page to see a list of all available markups. Select the markup you wish to view. The file opens up in a separate window.
   • Click on Review
• Select the Redline in the Available Markup Files in the screen
• Click **OK** to open the selected red line

**Tip:** If you *save each of the redline versions as separate files* in e-Builder, you will be able to compare at least two of the documents side by side. [See Compare Documents](#) for more information.
Save Redline as PDF or Image File

Saving redlines as PDF or image files allow you to save the redline markup to your local machine. This is the only way to save redlined files and make them available outside of e-Builder. This also allows you to make marked up files available to team members that do not have permissions to view redlined documents.

To save redline documents as PDF or image files:

1. Open the redline document you want to save.

2. Click the **Save and Publish** icon.

3. To save as a PDF file, click **Publish to PDF**.

   Or

   To save as an image file, click **Save Current View as JPG**.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish to CSF</td>
<td>Ctrl+Shift+K</td>
</tr>
<tr>
<td>Publish to PDF</td>
<td>Ctrl+Shift+D</td>
</tr>
<tr>
<td>Publish to TIFF</td>
<td>Ctrl+Shift+T</td>
</tr>
<tr>
<td>Save Current View as JPG</td>
<td>Ctrl+Shift+J</td>
</tr>
</tbody>
</table>
**Processes**

Workflow processes are started from the Processes module. Existing pending and finished processes can be accessed for viewing.

**Start a Process**

To initiate a process, such as a Change Order, Invoice or Proposal Request, for example:

1. After selecting your project, click **Processes** from the Project Menu.

![Project Menu](image)

The Project Processes page displays.

![Processes for](image)

2. Click **Start Process** in the upper right corner. The Start Process window appears.

![Start Process](image)

3. Select the process you wish to start from the Process list. The selected process page displays for you to complete.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Order (Bundle PR and/or CCD Items) (CO2)</td>
<td>(NEW) Change Order process to be used by PM’s to Bundle previously negotiated Proposal Requests (PR) and/or Construction Change Directives (CCD).</td>
</tr>
<tr>
<td>Construction Change Directive (CCD)</td>
<td>A/E, PM, and Haz Mat Consult initiate. CCD document is routed, signed and issued to Contractor. Work is completed - Contractor enters final price. Upon acceptance, CCD is placed in “Hold for CO” and now an available choice in Change Order (CO).</td>
</tr>
</tbody>
</table>

4. Complete all necessary fields.

5. Click **Submit**.
Take Action on a Process

When action is required of you, you will receive an email notification and the process will appear on the Home tab in e-Builder in the Workflows in your court section.

You can access the process by clicking on the process under the available Name links or by going to the Project Processes page and filtering the Processes In My Court.

1. Using any of the methods mentioned above, click the subject of the process to open the process instance window.
2. Complete all necessary fields, and then click the drop-down arrow in the **Please select an action field** to see the actions that you can take on this process. Select the action from the drop-down.

4. Click **Take Action** to move the process to the next step.

**Tip**: To check on the status of your process, you can filter for processes that you’ve initiated at any time.
Filter Processes

The filter process area has a number of criteria to help you search for pending or finished processes.

1. Search In:
   - These options help you narrow search results. Search for processes that you've initiated, those in your court or both.

2. Type of Process:
   - Click to choose either all processes or a specific process by name. If a Status option is selected in combination with the All Processes option, you will filter for all processes of the selected status. If a status is not selected, All Statuses will filter for all processes of every status that you have the permissions to see.
     - **Draft**: Only users in roles authorized to see draft processes, account and project administrators are able to filter for drafts. Drafts can also be managed from the Unfinished Drafts page.
     - **Open**: Only users in roles authorized to see all process instances account and project administrators are able to filter for open processes.
     - **Finished**: Only users in roles authorized to see all process instances account and project administrators are able to filter for finished processes.
3. **Status:**
   - Select to filter by a specific process status.

4. **Containing Text:**
   - Enter text to search for keywords located in the process details, such as the process name, subject or field descriptions.

5. **Filter**
   - Click this button after entering search criteria. Results display in the processes table toward the bottom of the page.

6. **Process Table**
   - This table displays the results of your filter. This table lists detailed information about the process, including the process name, subject, in which step it's in, its duration in the current step, the due date and status.
   - Processes that are grayed out are completed and those whose titles are in blue are currently active. Click the process number or subject to open the Process Details page.
**Architect/Engineer (A/E) role in e-Builder**

A/E are responsible to review, approve, and start processes in e-Builder. They are also responsible to upload documents into the workflow processes and folder structure.

The workflow processes listed below are processes that Architect/Engineer will initiates. A/E will also be reviewing and approving other processes created by other roles in e-Builder.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architect’s Supplemental Instructions (ASI)</td>
<td>NEW ASI Process (w/Spawn PR or CCD): AE’s and Haz Mat Consultants shall use this Process to issue a Architect’s Supplemental Instructions (ASI) to Contractors. Depending on the selected “Change Type” this process may spawn a CCD or PR process.</td>
</tr>
<tr>
<td>Change Order (Bundle PR and/or CCD Items) (CO2)</td>
<td>(NEW) Change Order process to be used by PM’s to Bundle previously negotiated Proposal Requests (PR) and/or Construction Change Directives (CCD).</td>
</tr>
<tr>
<td>Construction Change Directive ( CCD)</td>
<td>A/E, PM, and Haz Mat Consultant initiate. CCD document is routed, signed and issued to Contractor. Work is completed - Contractor enters final price. Upon acceptance, CCD is placed in “Hold for CO” and now an available choice in Change Order (CO).</td>
</tr>
<tr>
<td>Insurance Tracker (INS)</td>
<td>Process used to supply and track insurance coverage information/expiration dates.</td>
</tr>
<tr>
<td>Invoice Approval (INV)</td>
<td>Process for routing and approval of non-Contractor invoices.</td>
</tr>
<tr>
<td>Proposal Requests (PR)</td>
<td>A/E, PM, and Haz Mat Consultant initiate Proposal Request (PR) to Contractor for Changed Work. Upon acceptance of the Contractor’s Proposal, PR is placed in a “Hold for CO” step where it becomes available for selection in to a Change Order (CO).</td>
</tr>
</tbody>
</table>

**Documents uploaded by Architect/Engineer**

<table>
<thead>
<tr>
<th>Design</th>
<th>SD.80</th>
<th>Design Standard Variance Request Form</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BA.10.1</td>
<td>Online Instructions for Designers</td>
</tr>
<tr>
<td>Payment</td>
<td>CC.60</td>
<td>AE Design services Invoice</td>
</tr>
<tr>
<td></td>
<td>CC.61</td>
<td>Non-Design Consultant Services Invoice</td>
</tr>
<tr>
<td>Contract</td>
<td>CC.20</td>
<td>PT Services Certificate of Insurance</td>
</tr>
<tr>
<td>Construction Changes</td>
<td>CO.70</td>
<td>Construction Change Directive Form</td>
</tr>
<tr>
<td></td>
<td>CC.41</td>
<td>Construction Change Order</td>
</tr>
</tbody>
</table>

**Consultant (Non-AE) role in e-Builder.**

**Role:** Consultant - Haz Mat, Consultant – Other, Commissioning Agent

Consultants are responsible to review, approve, and start processes in e-Builder. They are also responsible to upload documents into the workflow processes and folder structure.

The workflow processes listed below are processes that Consultants will initiates. Consultants will also be reviewing and approving other processes created by other roles in e-Builder.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insurance Tracker (INS)</td>
<td>Process used to supply and track insurance coverage information/expiration dates.</td>
</tr>
<tr>
<td>Invoice Approval (INV)</td>
<td>Process for routing and approval of non-Contractor Invoices.</td>
</tr>
</tbody>
</table>
Contractor role in e-Builder

Roles: Contractor - Haz Mat, Contractor – Other, Contractor – Prime, Construction Manager

Contractors are responsible to review, approve, and start processes in e-Builder. They are also responsible to upload documents into the workflow processes and folder structure.

The workflow processes listed below are processes that Contractors will initiate. Contractors will also be reviewing and approving other processes created by other roles in e-Builder.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insurance Tracker (INS)</td>
<td>Process used to supply and track insurance coverage information/expiration dates.</td>
</tr>
<tr>
<td>Payment Application (PA)</td>
<td>Process for routing Construction Payment Applications (including Final Payment)</td>
</tr>
<tr>
<td>Request for Information (RFI2)</td>
<td>NEW RFI Process (w/Spawned PR or CCD); Contractor, Construction Manager, and Haz Mat Contractors shall use this process to issue a Request for Information (RFI) to Architects. Dependent upon selected “Response Type” this process may spawn CCD or PR.</td>
</tr>
<tr>
<td>Submittals (SUB)</td>
<td>Use this workflow to add submittals for your project.</td>
</tr>
</tbody>
</table>

Documents upload by Contractor

<table>
<thead>
<tr>
<th>Bid &amp; Award Submittal</th>
<th>DIV00.4313</th>
<th>Bid Bond</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DIV00.4513</td>
<td>Responsible Contractor Verification Attachment A</td>
</tr>
<tr>
<td></td>
<td>DIV00.4536</td>
<td>Affirmative Action Certificate</td>
</tr>
<tr>
<td></td>
<td>DIV00.4537</td>
<td>Workforce Certification Attachment B</td>
</tr>
<tr>
<td></td>
<td>DIV00.4540</td>
<td>Equal Pay Certificate of Compliance or Exemption Attachment C</td>
</tr>
<tr>
<td></td>
<td>DIV00.4539</td>
<td>Preference: TG/ED-Attachment D</td>
</tr>
<tr>
<td></td>
<td>DIV00.4545</td>
<td>Veteran Owned-Attachment E</td>
</tr>
<tr>
<td></td>
<td>ST.74</td>
<td>Corporate Acknowledgment for</td>
</tr>
<tr>
<td></td>
<td>CC.21</td>
<td>Construction Certificate of Insurance</td>
</tr>
</tbody>
</table>

| Award Submittal         | ST.72      | Performance Bond for Construction             |
|                        | ST.73      | Payment Bond for Construction                 |
|                        | DIV004335  | Attachment A-1                                |

<p>| Closeout                | DIV00.6573 | Contractor Affidavit of Withholding IC134     |
|                        | ST.75      | Acknowledgement of Corporate Surety           |</p>
<table>
<thead>
<tr>
<th>Process Name</th>
<th>Prefix</th>
<th>Description</th>
<th>Role(s) that can start the process</th>
</tr>
</thead>
<tbody>
<tr>
<td>Architect's Supplemental Instructions</td>
<td>ASI2</td>
<td>NEW ASI Process (w/Spawn PR or CCD): AE's and Haz Mat Consultants shall use this Process to issue a Architect’s Supplemental Instructions (ASI) to Contractors. Depending on the selected &quot;Change Type&quot; this process may spawn a CCD</td>
<td>A/E</td>
</tr>
<tr>
<td>Change Order (Bundle PR and/or CCD Items)</td>
<td>CO2</td>
<td>(NEW) Change Order process to be used by PM''s to Bundle previously negotiated Proposal Requests (PR) and/or Construction Change Directives (CCD).</td>
<td>A/E, OR, PM</td>
</tr>
<tr>
<td>Construction Change Directive</td>
<td>CCD</td>
<td>A/E, PM, and Haz Mat Consult initiate. CCD document is routed, signed and issued to Contractor. Work is completed - Contractor enters final price. Upon acceptance, CCD is placed in &quot;Hold for CO&quot; and now an available choice in Change Order</td>
<td>A/E, OR, PM</td>
</tr>
<tr>
<td>Invoice Approval</td>
<td>INV</td>
<td>Process for routing and approval of non-Contractor Invoices.</td>
<td>A/E, Consultants</td>
</tr>
<tr>
<td>Proposal Requests</td>
<td>PR</td>
<td>A/E, PM, and Haz Mat Consultant initiate Proposal Request (PR) to Contractor for Changed Work. Upon acceptance of the Contractor’s Proposal, PR is placed in a &quot;Hold for CO&quot; step where it becomes available for selection in to a Change Or</td>
<td>A/E, OR, PM</td>
</tr>
<tr>
<td>Document Signature Process</td>
<td>DSR</td>
<td>This process is used to set up electronic signature for a user.</td>
<td>All</td>
</tr>
<tr>
<td>Insurance Tracker</td>
<td>INS</td>
<td>Process used to supply and track insurance coverage information/expiration dates.</td>
<td>All</td>
</tr>
<tr>
<td>Payment Application</td>
<td>PA</td>
<td>Process for routing Construction Payment Applications (including Final Payment)</td>
<td>Contractor-Prime, Contractor-Other, Contractor-Haz Mat, Construction Manager</td>
</tr>
<tr>
<td>Request for Information</td>
<td>RFI2</td>
<td>NEW RFI Process (w/Spawned PR or CCD): Contractor, Construction Manager, and Haz Mat Contractors shall use this Process to issue a Request for Information (RFI) to Architects. Dependent upon selected &quot;Response Type&quot; this process may spawn</td>
<td>Contractor-Prime</td>
</tr>
<tr>
<td>Submittals</td>
<td>SUB</td>
<td>Use this workflow to add submittals for your project.</td>
<td>Contractor-Prime, Contractor-Other, Contractor-Haz Mat, Construction Manager</td>
</tr>
<tr>
<td>Construction Contract Approval</td>
<td>CCA</td>
<td>Process for routing construction contracts i.e. Construction, CM@r, &amp; Construction-Other</td>
<td>PM, PM Support, OR, SO Program Manager</td>
</tr>
<tr>
<td>Contract Amendment-</td>
<td>CAM</td>
<td>Process for amendments to a Consultant, A/E, or Owner's Rep Contract.</td>
<td>PM, PM Support, OR, SO Program Manager</td>
</tr>
<tr>
<td>Contract Approval-1</td>
<td>CAP</td>
<td>Process for routing and approval of all non-construction Contracts. (FOR FACILITIES P/T MASTER CONTRACT USE PURCHASE REQUISITION PROCESS)</td>
<td>PM, PM Support, OR, SO Program Manager</td>
</tr>
<tr>
<td>Process Name</td>
<td>Prefix</td>
<td>Description</td>
<td>Role(s) that can start the process</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>GMP Construction Change Order</td>
<td>CMRA</td>
<td>This Construction Change Order process used solely for establishing of the Guaranteed Maximum Price and Contract Time for the Work of a Construction Manager as Constructor. All changes made to the CM Agreement will use this process.</td>
<td>PM, PM Support, OR, SO Program Manager</td>
</tr>
<tr>
<td>Purchase Requisition</td>
<td>PO</td>
<td>Process for routing and approval of Purchase Requisitions under a Facilities P/T Master Contract &lt;$100,000.00, Goods and Materials &gt; $100,000.00 or Other type.</td>
<td>OR, PM, PM Support</td>
</tr>
<tr>
<td>Budget Change Process</td>
<td>BCHG</td>
<td>Process used to make Budget Changes after the Original Budget has been Approved</td>
<td>OR, PM, PM Support</td>
</tr>
<tr>
<td>Budget Initiation</td>
<td>BI</td>
<td>Process used to establish an Original Project Budget in e-Builder and to perform a check to determine availability of required Funding.</td>
<td>OR, PM, PM Support</td>
</tr>
<tr>
<td>Encumbrance Adjustment</td>
<td>EADJ</td>
<td>Process for routing and approval of Encumbrance Adjustments to account for increases or decreases in Commitments of PT Master contracts and general PO’s. EXCLUDING Construction and bid out Professional Technical Contracts. This interfaces with I</td>
<td>OR, PM, PM Support</td>
</tr>
<tr>
<td>Fiscal Year Rollover &amp; Funding Source Adjustment</td>
<td>FYR</td>
<td>Process to move the remaining encumbrance balances from the Current Fiscal Year, to the next Fiscal Year. Also, for adjusting Funding Source allocations. NOTE: THIS PROCESS DOES NOT INTERFACE WITH ISRS.</td>
<td>PM, PM Support, SO Finance</td>
</tr>
<tr>
<td>HAPR Funds Release Part 2</td>
<td>HFR</td>
<td>Process requesting HAPR Fund Release Part 2 for Planned Need. This is after the bidding has been completed and Project Budget Worksheet has been updated to reflect the bidding amount.</td>
<td>OR, PM, PM Support</td>
</tr>
<tr>
<td>HAPR Funds Request - Urgent Need</td>
<td>HFRU</td>
<td>This process is used to request HAPR funds for Urgent Need.</td>
<td>OR, PM</td>
</tr>
<tr>
<td>Net 0 Encumbrance Adjustment</td>
<td>NET0</td>
<td>Process for routing and approval of Net Zero Encumbrance Adjustments to account for Commitment Changes which do not alter a Commitment's overall Value. This will interface with ISRS.</td>
<td>PM, PM Support, CU Authorized Approver</td>
</tr>
<tr>
<td>Net 0 Encumbrance Adjustment (NO ISRS INTERFACE)</td>
<td>NOISR</td>
<td></td>
<td>PM, PM Support, CU Authorized Approver</td>
</tr>
<tr>
<td>Post-Payment Net 0 Adjustment</td>
<td>PPN0</td>
<td></td>
<td>PM, PM Support, CU Authorized Approver</td>
</tr>
<tr>
<td>Project Closeout</td>
<td>CLO</td>
<td>Process for Project Closeout including changing Project Status to &quot;Closed&quot; once the process is complete.</td>
<td>PM, PM Support, OR</td>
</tr>
<tr>
<td>Project Initiation</td>
<td>PI</td>
<td>Process to start project and obtain funding</td>
<td>PM, PM Support, OR</td>
</tr>
</tbody>
</table>

Workflow Processes Step by Step Guides are available by clicking the link below than select e-Builder.
http://www.minnstate.edu/system/finance/facilities/design-construction/index.html